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About This Guide

This GroupWise 18 Interoperability Guide helps you use GroupWise in the context of other software 
products.

The following resources provide additional information about using GroupWise 18:

 Micro Focus Support and Knowledgebase (https://www.microfocus.com/support/GroupWise)

To search the GroupWise documentation from the Micro Focus Support website, click Advanced 
Search, select Documentation in the Search In drop-down list, select GroupWise in the Products 
drop-down list, type the search string, then click Search.

 GroupWise Support Community (https://community.microfocus.com/collaboration/gw/
groupwise/)

Audience
This guide is intended for network administrators who install and administer GroupWise. 

Feedback
We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comment feature at the bottom of each page of the 
online documentation.

Additional Documentation
For additional GroupWise documentation, see the Micro Focus GroupWise 18 Documentation 
website (https://www.novell.com/documentation/groupwise18/).
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I I Clustering

The following sections provide information about clustering with GroupWise.

 Chapter 1, “Using Novell Cluster Services (NCS) with GroupWise 18,” on page 9
 Chapter 2, “Using Windows Server Failover Clustering with GroupWise 18,” on page 19
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1 1Using Novell Cluster Services (NCS) with 
GroupWise 18

 “Creating a New GroupWise System to Work with Novell Cluster Services” on page 9
 “Upgrading a Clustered Linux GroupWise System to GroupWise 18” on page 13

Creating a New GroupWise System to Work with Novell 
Cluster Services

For detailed instructions on configuring GroupWise to work with Novell Cluster Services (NCS), see 
“Novell Cluster Services on Linux” in the GroupWise 2012 Interoperability Guide. The procedure for 
installing GroupWise 18 differs from the GroupWise 2012 procedure in the following ways:

 “GroupWise 18 Installation Wizard” on page 9
 “GroupWise 18 Admin Console” on page 10
 “GroupWise 18 Admin Service” on page 10
 “GroupWise 18 Installation Console” on page 11
 “GroupWise 18 Load and Unload Scripts” on page 11
 “GroupWise 18 Cluster Test” on page 13

GroupWise 18 Installation Wizard
The GroupWise 18 Installation Wizard is completely different from the GroupWise 2012 Installation 
program. Therefore, the specific installation instructions in “Setting Up a New GroupWise System in 
a Linux Cluster” in the GroupWise 2012 Interoperability Guide no longer apply. There is no longer a 
Configure GroupWise for Clustering option for taking care of certain clustering configuration tasks. 
Those tasks are taken care of in other ways in GroupWise 18. 

1 Install the GroupWise Server component on each cluster node where a GroupWise agent will 
run for a domain or a post office.
Follow the instructions in Step 1 through Step 9 in “Linux: Installing the GroupWise Server 
Software” in the GroupWise 18 Installation Guide.

IMPORTANT: Install the GroupWise Server component on all cluster nodes before setting up 
any domains or post offices. Do not start the GroupWise Installation Console at the end of the 
installation process.
Using Novell Cluster Services (NCS) with GroupWise 18 9
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GroupWise 18 Admin Console
In GroupWise 18, the GroupWise Admin console replaces ConsoleOne as the GroupWise 
administration tool. The instructions that include ConsoleOne in the GroupWise 2012 
Interoperability Guide can easily be adapted to apply to the GroupWise Admin console in GroupWise 
18. For more information, see “Working with the GroupWise Administration Console” in GroupWise 
18 Installation Guide and “GroupWise Administration Console” in the GroupWise 18 Administration 
Guide.

GroupWise 18 Admin Service
You must configure the GroupWise Admin Service to function in a cluster, so that it keeps track of 
which cluster resources are available to it at each point in time. Configuring the GroupWise Admin 
Service for clustering ensures that files associated with domains and post offices are created on 
cluster volumes, rather than on individual cluster nodes.

On each cluster node:

1 Run the following command to enable the GroupWise Admin Service to run in a clustering 
environment:

gwadminutil config -cluster enable
You should receive the following response:

Cluster: enabled
Default Port: 9710

2 Use the following command to restart the GroupWise Admin Service.

rcgrpwise restart gwadminservice
Your GroupWise system is now ready to function in a cluster.

File Standard Location Clustered location

Domain SSL Certificate, 
MTA SSL Certificate, GWIA 
SSL Certificate

/opt/novell/groupwise/certificates /groupwise/certificates
(a peer to the domain folder)

Post Office SSL Certificate, 
POA SSL Certificate

/opt/novell/groupwise/certificates /groupwise/certificates
(a peer to the post office folder)

MTA Log Files /var/log/novell/groupwise/
domain.mta

/groupwise/agents/logs
(a peer to the domain folder)

GWIA Log Files /var/log/novell/groupwise/
gwia.domain

/groupwise/agents/logs
(a peer to the domain folder)

POA Log Files /var/log/novell/groupwise/
post_office.poa

/groupwise/agents/logs
(a peer to the post office folder)
10 Using Novell Cluster Services (NCS) with GroupWise 18
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GroupWise 18 Installation Console
In the Installation console, when you are creating domains and post offices in a cluster, a few fields 
require cluster-specific information.

 Domain Fields
 Post Office Fields

Domain Fields
When you follow the instructions in “Creating the Primary Domain” in the GroupWise 18 Installation 
Guide, pay special attention to the following fields:

 In the Host field, specify the secondary IP address of the shared resource where you want to 
create the domain.

 In the Domain Folder field, specify a folder on the shared resource where you want to create the 
domain.

Post Office Fields
When you follow the instructions in Step 2 through Step 8 in “Adding a Post Office” in the 
GroupWise 18 Installation Guide, pay special attention to the following fields:

 In the Owning Domain Host field, specify the secondary IP address of the shared resource where 
the owning domain is located.

 In the Owning Domain Admin Port field, specify the port on the shared resource for the domain.
 In the Host field, specify the secondary IP address of the shared resource where you want to 

create the post office.
 In the Post Office Folder field, specify a folder on the shared resource where you want to create 

the post office.

GroupWise 18 Load and Unload Scripts
The sample load and unload scripts that are provided in the following sections of “Novell Cluster 
Services on Linux” in the GroupWise 2012 Interoperability Guide should not be used with GroupWise 
18:

 “Configuring GroupWise Cluster Resources to Load and Unload the Linux Agents”
 “Configuring the Linux GWIA Cluster Resource to Load and Unload the GWIA and Its MTA”

Use the following scripts instead:

 Sample Cluster Load Script
 Sample Cluster Unload Script

Sample Cluster Load Script
This sample cluster load script performs the following actions:

 Establishes what to do for certain error conditions.
 Creates the GroupWise agent services (if they do not already exist).
Using Novell Cluster Services (NCS) with GroupWise 18 11
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 Starts the GroupWise Admin Service listeners with clustering enabled for the MTA and POA.
 Starts the POA, MTA, and GWIA (in that order if all are present)

#!/bin/bash
./opt/novell/ncs/lib/ncsfuncs
exit_on_error nss /poolact=DOM
exit_on_error ncpcon mount DOM=254
exit_on_error add_secondary_ipaddress 151.155.136.248
exit_on_error ncpcon bind --ncpservername=DOM --ipaddress=151.155.136.248
exit_on_error novcifs --add '--
vserver=".cn=DOM.ou=servers.o=novell.t=GW14-TREE."'

--ip-addr=151.155.136.248
# Start gwadmin service
exit_on_error /etc/init.d/grpwise start gwadminservice
#create agent services
exit_on_error /opt/novell/groupwise/admin/gwadminutil services 

-i /media/nss/DOM/utah
exit_on_error /opt/novell/groupwise/admin/gwadminutil services 

-i /media/nss/DOM/utah/
wpgate/gwia
exit_on_error /opt/novell/groupwise/admin/gwadminutil services 

-i /media/nss/DOM/provo
#start admin service listeners
exit_on_error /opt/novell/groupwise/admin/gwadmin-ipc start utah cluster
exit_on_error /opt/novell/groupwise/admin/gwadmin-ipc start provo.utah 
cluster
#start GroupWise agents
exit_on_error /etc/init.d/grpwise start utah
exit_on_error /etc/init.d/grpwise start gwia.utah
exit_on_error /etc/init.d/grpwise start provo.utah
exit 0

Sample Cluster Unload Script
This sample cluster unload script performs the following actions:

 Stops the GroupWise Admin Service listeners for the MTA and POA
 Stops the MTA, GWIA, and POA (in that order if all are present)
 Lists error conditions that can be ignored

#!/bin/bash
. /opt/novell/ncs/lib/ncsfuncs
# Stop admin service listeners
ignore_error /opt/novell/groupwise/admin/gwadmin-ipc stop utah
ignore_error /opt/novell/groupwise/admin/gwadmin-ipc stop provo.utah
# Stop GroupWise agents
ignore_error /etc/init.d/grpwise stop utah
ignore_error /etc/init.d/grpwise stop gwia.utah
ignore_error /etc/init.d/grpwise stop provo.utah
12 Using Novell Cluster Services (NCS) with GroupWise 18



ignore_error novcifs 
--remove '--vserver=".cn=DOM.ou=servers.o=novell.t=GW14-

TREE."' 
--ip-addr=151.155.136.248

ignore_error ncpcon unbind --ncpservername=DOM --ipaddress=151.155.136.248
ignore_error del_secondary_ipaddress 151.155.136.248
ignore_error nss /pooldeact=DOM
exit 0

GroupWise 18 Cluster Test
Follow the instructions in “Testing Your Clustered GroupWise System on Linux” to verify that the 
GroupWise Admin console keeps track of the cluster resources that are currently available to it.

Upgrading a Clustered Linux GroupWise System to 
GroupWise 18

 “Installing the GroupWise 18 Software” on page 13
 “Configuring the GroupWise Admin Service to Function in a Cluster” on page 14
 “Upgrading Domains and Post Offices” on page 15
 “Finishing the GroupWise Software Upgrade” on page 15
 “Providing New Load and Unload Scripts” on page 16
 “Testing the Upgraded Cluster” on page 17

Installing the GroupWise 18 Software
As with any upgrade, you must upgrade the primary domain first.

1 Stop all GroupWise agents that are running on the node that you want to upgrade first.
2 Install the GroupWise Server component on the first node.

Follow the instructions in Step 1 through Step 9 in “Linux: Installing the GroupWise Server 
Software” in the GroupWise 18 Installation Guide.

IMPORTANT: Do not start the GroupWise Admin console after installing the GroupWise 
software.

3 Continue with Configuring the GroupWise Admin Service to Function in a Cluster.
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Configuring the GroupWise Admin Service to Function in a 
Cluster
You must configure the GroupWise Admin Service to function in a cluster, so that it keeps track of 
which cluster resources are available to it at each point in time. Configuring the GroupWise Admin 
Service for clustering ensures that files associated with domains and post offices are created on 
cluster volumes, rather than on individual cluster nodes.

1 Run the following command to enable the GroupWise Admin Service to run in a clustering 
environment:

gwadminutil config -cluster enable
You should receive the following response:

Cluster: enabled
Default Port: 9710

2 Use the following command to restart the GroupWise Admin Service.

rcgrpwise restart gwadminservice
Your GroupWise system is now ready to function in a cluster.

3 For convenience, configure the GroupWise Installation console to use an authentication mode 
of a user name and password, rather than the default token-based authentication mode:

gwadminutil installcfg -m user -u user_name -p password

4 Continue with Upgrading Domains and Post Offices.

File Standard Location Clustered location

Domain SSL Certificate, 
MTA SSL Certificate, GWIA 
SSL Certificate

/opt/novell/groupwise/certificates /groupwise/certificates
(a peer to the domain folder)

Post Office SSL Certificate, 
POA SSL Certificate

/opt/novell/groupwise/certificates /groupwise/certificates
(a peer to the post office folder)

MTA Log Files /var/log/novell/groupwise/
domain.mta

/groupwise/agents/logs
(a peer to the domain folder)

GWIA Log Files /var/log/novell/groupwise/
gwia.domain

/groupwise/agents/logs
(a peer to the domain folder)

POA Log Files /var/log/novell/groupwise/
post_office.poa

/groupwise/agents/logs
(a peer to the post office folder)
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Upgrading Domains and Post Offices
For background information about upgrading your GroupWise system, see “GroupWise System 
Upgrade” in the GroupWise 18 Installation Guide.

1 In a web browser, start the GroupWise Installation console:

https://domain_server_secondary_ip_address:9710/gwadmin-console/
install

2 Provide the user name as password that you established in Step 3 in “Configuring the 
GroupWise Admin Service to Function in a Cluster” on page 14.

3 In the GroupWise Installation console, click Upgrade an Existing Domain or Post Office 
GroupWise 18.
The Installation console provides a list of agents on the current node. The list is built from the 
gwha.conf file.

4 (Conditional) If there are any domains or post offices that are not currently online to this node, 
select them, then click Remove to remove them from the list.

5 For each domain and post office, verify that the IP address in the list is the secondary IP address 
of the cluster resource.

6 For each domain and post office, verify that there are no port conflicts for the Admin port.
7 (Conditional) If you need to change the IP address or Admin port for a domain or post office, 

click the name of the domain or post office, update the information, then click OK.
8 Click Next to continue with the upgrade.
9 On the Credentials page:

9a (Conditional) If the primary domain is being upgraded, specify the user name for the 
GroupWise Super Admin, and type the password twice for confirmation.
or
Specify the IP address, Admin port, and Admin credentials of the owning domain.

10 Click Next to display the Summary page.
11 Review the summary, then click Finish.
12 Continue with Finishing the GroupWise Software Upgrade.

Finishing the GroupWise Software Upgrade
1 On each cluster node, repeat the steps in the following sections:

 “Installing the GroupWise 18 Software” on page 13
 “Configuring the GroupWise Admin Service to Function in a Cluster” on page 14
 “Upgrading Domains and Post Offices” on page 15

Remember that you cannot upgrade a post office until its owning domain as been 
upgraded.

2 Continue with Providing New Load and Unload Scripts.
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Providing New Load and Unload Scripts
1 In iManager, replace the existing load script for each cluster resource with a new load script that 

is similar to the following example:

#!/bin/bash
./opt/novell/ncs/lib/ncsfuncs
exit_on_error nss /poolact=DOM
exit_on_error ncpcon mount DOM=254
exit_on_error add_secondary_ipaddress 151.155.136.248
exit_on_error ncpcon bind --ncpservername=DOM --
ipaddress=151.155.136.248
exit_on_error novcifs --add '--
vserver=".cn=DOM.ou=servers.o=novell.t=GW14-TREE."'

--ip-addr=151.155.136.248
# Start gwadmin service
exit_on_error /etc/init.d/grpwise start gwadminservice
#create agent services
exit_on_error /opt/novell/groupwise/admin/gwadminutil services 

-i /media/nss/DOM/utah
exit_on_error /opt/novell/groupwise/admin/gwadminutil services 

-i /media/nss/DOM/utah/
wpgate/gwia
exit_on_error /opt/novell/groupwise/admin/gwadminutil services 

-i /media/nss/DOM/provo
#start admin service listeners
exit_on_error /opt/novell/groupwise/admin/gwadmin-ipc start utah 
cluster
exit_on_error /opt/novell/groupwise/admin/gwadmin-ipc start provo.utah 
cluster
#start GroupWise agents
exit_on_error /etc/init.d/grpwise start utah
exit_on_error /etc/init.d/grpwise start gwia.utah
exit_on_error /etc/init.d/grpwise start provo.utah
exit 0
This sample cluster load script performs the following actions:
 Establishes what to do for certain error conditions.
 Creates the GroupWise agent services (if they do not already exist).
 Starts the GroupWise Admin Service listeners with clustering enabled for the MTA and 

POA.
 Starts the POA, MTA, and GWIA (in that order if all are present)

2 Replace the existing unload script for each cluster resource with a new unload script that is 
similar to the following example:

#!/bin/bash
. /opt/novell/ncs/lib/ncsfuncs
# Stop admin service listeners
ignore_error /opt/novell/groupwise/admin/gwadmin-ipc stop utah
ignore_error /opt/novell/groupwise/admin/gwadmin-ipc stop provo.utah
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# Stop GroupWise agents
ignore_error /etc/init.d/grpwise stop utah
ignore_error /etc/init.d/grpwise stop gwia.utah
ignore_error /etc/init.d/grpwise stop provo.utah
ignore_error novcifs 

--remove '--vserver=".cn=DOM.ou=servers.o=novell.t=GW14-
TREE."' 

--ip-addr=151.155.136.248
ignore_error ncpcon unbind --ncpservername=DOM --
ipaddress=151.155.136.248
ignore_error del_secondary_ipaddress 151.155.136.248
ignore_error nss /pooldeact=DOM
exit 0
This sample cluster unload script performs the following actions:
 Stops the GroupWise Admin Service listeners for the MTA and POA
 Stops the MTA, GWIA, and POA (in that order if all are present)
 Lists error conditions that can be ignored

NOTE: The pkill command used in earlier versions of the GroupWise unload script is no 
longer needed. In GroupWise 18, the grpwise script terminates GroupWise agent processes 
according to the wait setting specified in the gwha.conf file. The default is 60 seconds. If that 
amount of time is not sufficient to ensure a clean shutdown of the agents in your GroupWise 
system, increase the wait setting as needed.

3 Continue with Testing the Upgraded Cluster.

Testing the Upgraded Cluster
1 Follow the instructions in “Testing Your Clustered GroupWise System on Linux” to verify that 

the GroupWise Admin console keeps track of the cluster resources that are currently available 
to it.
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2 2Using Windows Server Failover Clustering 
with GroupWise 18

Windows Server 2012 Failover Clustering and Windows Server 2008 Failover Clustering are very 
similar in regards to how GroupWise 18 interacts with them. In Windows Server 2012 Failover 
Clustering, the term “Cluster Role” replaces the term “Cluster Resource” as used in Windows Server 
2008 Failover Clustering. The example in this section uses Windows Server 2012 functionality and 
terminology.

 “Creating a New GroupWise 18 System in a Windows Failover Cluster” on page 19
 “Upgrading a Clustered Windows GroupWise System to GroupWise 18” on page 27

Creating a New GroupWise 18 System in a Windows 
Failover Cluster

The following sections assume a working knowledge of Windows Server Failover Clustering.

 “Preparing to Install GroupWise in the Cluster” on page 19
 “Installing the GroupWise Software” on page 20
 “Configuring the GroupWise Admin Service for Clustering” on page 21
 “Creating the Primary Domain” on page 21
 “Creating a Post Office” on page 22
 “Creating a Script to Start and Stop the GroupWise Agents” on page 24
 “Adding the Script to the Cluster Role” on page 25
 “Testing the Cluster Role” on page 26
 “Clustering the DVA” on page 27

Preparing to Install GroupWise in the Cluster
1 Define at least one Cluster Role.

For a very simple GroupWise system with a primary domain and one post office, you could 
handle the domain and the post office as a single Cluster Role. For a typical GroupWise system 
with multiple domains and post offices, you might to have a Cluster Role for each domain and 
post office.

2 Configure each Cluster Role with the type of File Server.
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3 Configure each File Server Cluster Role with a shared cluster disk and an IP address.
The following example shows two Cluster Roles, ProvoServer and UtahServer.

4 Continue with Installing the GroupWise Software.

Installing the GroupWise Software
1 Install the GroupWise Server component on each cluster node where a GroupWise agent will 

run for a domain or a post office.
Follow the instructions in Step 1 through Step 9 in “Windows: Installing the GroupWise Server 
Software” in the GroupWise 18 Installation Guide.

IMPORTANT: Install the GroupWise Server component on all cluster nodes before setting up 
any domains or post offices.

2 Continue with Configuring the GroupWise Admin Service for Clustering.
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Configuring the GroupWise Admin Service for Clustering
Configuring the GroupWise Admin Service for clustering ensures that files associated with domains 
and post offices are created on cluster volumes, rather than on individual cluster nodes.

1 Run the following command to enable the GroupWise Admin Service to run in a clustering 
environment:

gwadminutil config -cluster enable
You should receive the following response:

Cluster: enabled
Default Port: 9710

2 Restart the GroupWise Admin Service.
Use the Windows Services administrative tool.
or
Use the following commands at the Windows command prompt:

sc stop gwadmin
sc start gwadmin

3 Continue with Creating the Primary Domain.

Creating the Primary Domain
1 Ensure that the primary domain Cluster Role is online on the cluster node where you want to 

create the primary domain. 
2 Use the GroupWise Install icon on the Windows desktop to access the GroupWise Installation 

console.
3 (Conditional) If you receive a certificate error, continue past it.

File Standard Location Clustered location

Domain SSL Certificate, 
MTA SSL Certificate, GWIA 
SSL Certificate

c:\Program Files\Novell\
GroupWise Server\
certificates

\groupwise\certificates
(a peer to the domain folder)

Post Office SSL Certificate, 
POA SSL Certificate

c:\Program Files\Novell\
GroupWise Server\
certificates

\groupwise\certificates
(a peer to the post office folder)

MTA Log Files \domain_folder\mslocal \groupwise\agents\logs
(a peer to the domain folder)

GWIA Log Files \domain_folder\wpgate\000.prc \groupwise\agents\logs
(a peer to the domain folder)

POA Log Files \post_office_folder\wpcsout\ofs \groupwise\agents\logs
(a peer to the post office folder)
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4 Follow the instructions in “Creating the Primary Domain” in the GroupWise 18 Installation 
Guide.
Pay special attention to the Host and Domain Folder fields on the System Settings page.

 In the Host field, specify the IP address of the domain Cluster Role.
 In the Domain Folder field, specify a folder on the domain Cluster Role volume.

The clustering example used in this section sets up a GWIA in the primary domain but does 
not create any post offices on the primary domain server. The post office will be created 
later on a different Cluster Role.

5 Continue following the standard instructions to finish creating the primary domain.

NOTE: After you create the primary domain on its Cluster Role, the GroupWise Install and 
GroupWise Administration desktop icons no longer work. The Admin Service is now listening on 
the IP address of the primary domain Cluster Role, not the IP address of the physical node.

6 (Optional) Create new desktop shortcuts for the Installation console and the Administration 
console that use the proper IP address.

7 Continue with Creating a Post Office.

Creating a Post Office
Although you can create a post office on the same Cluster Role with a domain, it is not typical to do 
so. In this example, the post office is created on a separate Cluster Role.

1 Online the post office Cluster Role to a cluster node.
2 Use the GroupWise Install icon on the Windows desktop to access the GroupWise Installation 

console.
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3 Follow the instructions in Step 2 through Step 8 in “Adding a Post Office” in the GroupWise 18 
Installation Guide.
As with the domain creation process, pay special attention to specific fields.
3a On the System Settings page:

 In the Owning Domain Host field, specify the IP address of the primary domain Cluster 
Role that you set up in “Creating the Primary Domain” on page 21.

 In the Owning Domain Admin Port field, specify port on the primary domain Cluster 
Role.

3b On the Post Office Settings page:

 In the Host field, specify the IP address of the post office Cluster Role.
 In the Post Office Folder field, specify a folder on the post office Cluster Role volume.

The clustering example used in this section does not set up a DVA with the post office. 
For DVA clustering recommendations, see “Clustering the DVA” on page 27.

4 Continue following the standard instructions to finish creating the post office.

NOTE: As an alternative to creating the post office in the GroupWise Installation console, you 
can create the post office in the GroupWise Admin console. Online the post office Cluster Role 
to the same node where the owning domain Cluster Role is running. Then follow the 
instructions in “Creating a New Post Office on an Existing Domain or Post Office Server” in the 
GroupWise 18 Installation Guide.
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Creating a Script to Start and Stop the GroupWise Agents
When a domain or post office Cluster Role is started, stopped, or moved to a new cluster node, the 
accompanying GroupWise agents must also be started and stopped. The GroupWise Admin Service 
also needs to keep track of when domains and post office are added or removed from its cluster 
node. This is accomplished by adding a Windows cluster Generic Script resource to the domain or 
post office Cluster Role. 

The Generic Script performs the following actions:

 Creates a Windows service for each GroupWise agent if the service does not already exist.
 Starts the GroupWise Admin Service for the domain or post office Cluster Role.
 Starts the MTA, and optionally the GWIA, for a domain Cluster Role.
 Starts the POA for a post office Cluster Role.

The Generic Script must be a Visual Basic script. A template is provided in the following location:

c:\Program Files\Novell\GroupWise Server\
agents\data\cluster\groupwise_cluster_template.vbs

The script file provides background information about how to edit the script.

1 Create a folder for the script on each cluster node, such as c:\gwcluster.
2 Copy the template script into the gwcluster folder on each cluster node.
3 Edit the template file for a specific Cluster Role.

For a domain Cluster Role, the script would look similar to the following example, which enables 
the MTA and the GWIA for the Utah domain:

gwAgents.Add "Utah MTA", "M:\Utah"
gwAgents.Add "Utah GWIA", "M:\Utah\wpgate\gwia"
For a post office Cluster Role, the script would look similar to the following example, which 
enables the POA for the Provo post office:

gwAgents.Add "Provo POA", "M:\Provo"
4 Save the edited template file with a descriptive name that associates it with its Cluster Role.
5 Copy the customized script to each cluster node, ensuring that it is in the same location on all 

cluster nodes.
6 Continue with Adding the Script to the Cluster Role.
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Adding the Script to the Cluster Role
1 In the Failover Cluster Manager, stop or offline the Cluster Role.
2 Highlight the Cluster Role.

3 On the Actions menu in the right column, click Add Resource > Generic Script.
4 Select Generic Script as the resource type.

5 Specify the full path to the script.
6 Click Next, then click Finish.

IMPORTANT: If there are any errors in the script, or if the script is not available on all of the 
cluster nodes, the addition of the Generic Script resource fails.
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7 Edit the properties of the script to add dependencies, so that the file system and IP address are 
enabled on the Cluster Role before the script is run.

7a Highlight the Generic Script resource, then click Properties on the Script menu on the right.

7b Click the Dependencies tab.
7c Click Click here to add a dependency, then select the Cluster Disk as the first dependency.
7d Click Click here to add a dependency again, then add the IP address.
7e Click OK to save your changes.

8 Continue with Testing the Cluster Role.

Testing the Cluster Role
1 Bring the Cluster Role online.
2 Move the Cluster Role to a different node.
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Clustering the DVA
Complete instructions for clustering the DVA are beyond the scope of this example. The following 
suggestions should help you cluster the DVA:

 Do not install the DVA as part of installing a post office. Instead, install it independently. Use the 
following command on the cluster disk where you want the DVA to run:

gwadminutil services -i -dva 
For more instructions, see the following sections in the GroupWise 18 Installation Guide:
 “Windows: Installing and Starting a New DVA”
 “Setting Up the DVA”

 Create a script and a Generic Script resource to control the DVA. The line for the DVA would look 
similar to the following example:

gwAgents.Add "GWDVA", "M:\Provo"
For instruction, see:
 “Creating a Script to Start and Stop the GroupWise Agents” on page 24
 “Adding the Script to the Cluster Role” on page 25

 Configure the DVA to function in the cluster. 
This requires editing the DVA startup file. For instructions, see “Configuring DVA Log Settings” in 
the GroupWise 18 Administration Guide. 
Two aspects of the DVA must to customized:
 Configure the DVA with the IP address of the Cluster Role.
 Configure the DVA to create its log files in the following folder:

\groupwise\agents\logs
If you are setting up the DVA as part a post office Cluster Role, this folder has already been 
created when you configured the GroupWise Admin Service to run for the clustered post 
office. If not, you must manually create this folder. In either case, you must configure the 
DVA to have its log files created in this location. 

Upgrading a Clustered Windows GroupWise System to 
GroupWise 18

If your existing GroupWise system is in a cluster, you must change the way it is configured in the 
cluster to enable the GroupWise 18 domains, post offices, and agents to function in the cluster.

1 Stop the GroupWise agents for the domain or post office.
2 Remove the cluster Resource Group for the domain or post office.
3 Upgrade each domain or post office.

For instructions, see“GroupWise System Upgrade” in the GroupWise 18 Installation Guide
4 Create a Cluster Role for each domain or post office.

or
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Create a Cluster Role for a domain and one or more post offices, as required by the existing 
architecture of your Windows Failover cluster.
For instructions, see “Preparing to Install GroupWise in the Cluster” on page 19.

5 Create a script to control the agents in the Cluster Role.
For instructions, see:
 “Creating a Script to Start and Stop the GroupWise Agents” on page 24
 “Adding the Script to the Cluster Role” on page 25

6 Test the new Cluster Role.
For instructions, see “Testing the Cluster Role” on page 26.

7 (Optional) Cluster the DVAs in your GroupWise system.
For instructions, see “Clustering the DVA” on page 27.
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3 3Messenger

To show Messenger presence in GroupWise, one of the following must match between GroupWise 
and Messenger:

 GroupWise DN matches Messenger DN.
 GroupWise preferred email address matches the mail attribute stored in Messenger. You can 

store the mail attribute in Messenger by doing an LDAP sync.
 GroupWise preferred email address matches the userid@defaulthostid in Messenger that is 

constructed from the user settings and their assigned policy.

NOTE: Only the users in your contact list show their presence in GroupWise. If you don’t see a user’s 
presence in GroupWise, you must add them to your Messenger contact list and then restart the 
GroupWise client so it picks up the new Messenger contact.
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4 4Micro Focus Vibe

Before installing Micro Focus Vibe, you should thoroughly review the documentation provided at the 
Micro Focus Vibe documentation website (https://www.novell.com/documentation/vibe34/). These 
guides provide detailed product installation and configuration instructions, but they do not include 
specific instructions for integrating Micro Focus Vibe with GroupWise. This section of the GroupWise 
18 Interoperability Guide supplies these product-specific instructions.

 “Configuring GroupWise for Use with Micro Focus Vibe” on page 31
 “Accessing Your Vibe Site from the GroupWise Client” on page 33
 “Streamlining Authentication to Vibe” on page 33

Configuring GroupWise for Use with Micro Focus Vibe
When you install Micro Focus Vibe with GroupWise, some configuration steps are required to 
integrate the applications.

 “Understanding How Micro Focus Vibe Interacts with an LDAP Directory and GroupWise” on 
page 31

 “Authenticating through the LDAP Directory” on page 32
 “Using GroupWise as the Vibe Email System” on page 32
 “Enabling GroupWise/Vibe Integration for GroupWise Client Users” on page 32

Understanding How Micro Focus Vibe Interacts with an LDAP 
Directory and GroupWise
When you install Micro Focus Vibe in an environment where GroupWise is already set up, the 
products interact in the following ways:

 Vibe can use an LDAP directory (Micro Focus eDirectory or Microsoft Active Directory) to 
authenticate Vibe users. This means that you do not need to create Vibe users manually. Vibe 
can create its user accounts based on the users that already exist in the LDAP directory.

 Vibe can use GroupWise as its integrated email system. This means that email messages sent 
from the Vibe site are delivered to GroupWise mailboxes. It also means that GroupWise users 
can post items to Vibe folders by sending email messages to Vibe folders.

 Vibe information can be displayed in the GroupWise client. Starting in GroupWise 8.0.2, you 
can drag and drop GroupWise items into Vibe folders in the GroupWise Folder List to post items 
to the corresponding folders in your Vibe site. You can also use the GroupWise Find feature to 
search your Vibe site.
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Authenticating through the LDAP Directory
For instructions, see the following sections of the Vibe 4.0.8 Installation Guide.

 “Gathering Directory Services Information”
 “Adding Users to Your Vibe Site”

Using GroupWise as the Vibe Email System
For setup instructions, see the following sections of the Vibe 4.0.8 Installation Guide:

 “Planning for Outbound Email”
 “Planning to Enable Inbound Email”

See also the “Configuring Email Integration” section of the  Micro Focus Vibe 4.0.8 Administration 
Guide:

For basic email usage instructions, see the following sections of the Micro Focus Vibe 4.0.8 User 
Guide:

 “Sending Email to Team Members and Announcing the Workspace after Its Creation”
 “Subscribing to Email Notifications from a Folder”, “Setting Up a Folder to Receive Entries Via 

Email” and “Adding Entries to a Folder Via Email”
 “Sending Email from within Vibe”

See also the following sections of the Micro Focus Vibe 4.0.8 Advanced User Guide:

 “Enabling Folders to Receive Entries through Email” and “Configuring Folders to Send Email 
Notifications to Other Users”

 “Sending Email Notifications”
 “Emailing Files and Attachments to the Vibe Site When You Are Over Your Quota”

Enabling GroupWise/Vibe Integration for GroupWise Client 
Users
Before you can integrate GroupWise and Vibe, your Vibe site must be set up, as described in the 
Vibe 4.0.8 Installation Guide.

1 In the GroupWise Admin console, click Domains, Post Offices, or Users, then click the object 
where you want to make Vibe available to GroupWise client users.

2 Click Client Options > Integrations > Micro Focus Vibe.
3 Select Enable Micro Focus Vibe.
4 Provide the Vibe URL:

4a Use the following format:

https://vibe_server/ssf/ws/TeamingServiceV1
4b (Conditional) If you want to use HTTP instead of HTTPS, include it in the Micro Focus Vibe 

URL field, for example:
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http://vibe.yourcompanyname.com
4c (Conditional) If Vibe is not configured with the default HTTPS port, include the port 

number after the hostname, for example:

vibe.yourcompanyname.com:444
4d (Conditional) If Vibe is not installed in the default location, include the path to 

TeamingServiceV1, for example:

vibe.yourcompanyname.com/Web/Vibe/TeamingServiceV1
5 Click OK.

IMPORTANT: In order for GroupWise users to take advantage of GroupWise/Vibe integration, they 
must provide their GroupWise email address in their Vibe profile.

Accessing Your Vibe Site from the GroupWise Client
Before you can access the Vibe site from the GroupWise client, you must add your GroupWise email 
address to your Vibe profile, as described in “Modifying Your Profile” in the Micro Focus Vibe 4.0.8 
User Guide.

The GroupWise and Vibe Quick Start describes the Vibe functionality that becomes available in the 
GroupWise client as a result of the GroupWise/Vibe integration.

Streamlining Authentication to Vibe
You can implement single sign-on for use with Micro Focus Vibe, so that users do not need to log in 
separately to GroupWise and Vibe. See the following sections in “Planning an Advanced Vibe 
Installation” in the Vibe 4.0.8 Installation Guide:

 “Configuring Single Sign-On with Novell Access Manager”
 “Configuring Single Sign-On with Internet Information Services for Windows”
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5 5Micro Focus Filr

Using Micro Focus Filr with your GroupWise system allows you to store, search, and share 
attachments in Filr. Attachments sent this way take no space in the GroupWise mailbox and are 
automatically shared in Filr. This gives you better control over you attachments and the size of your 
mailboxes.

IMPORTANT: Attachments sent as Filr references are considered an external resource and are not 
part of the message. If you enable Filr, GroupWise attachments stored in Filr are not archived with 
Micro Focus Retain.

Enabling GroupWise for Use with Micro Focus Filr
To enable the Filr integration:

 In the GroupWise Admin console, select the Domain, Post Office, or user where you want the 
Filr integration enabled.

 Go to Client Options > Integrations > Micro Focus Filr and select Enable Micro Focus Filr.
 Enter the URL for your Filr server in the following format:

https://server_ip_or_dns:port

 (Optional) Select Force storage of attachments in Micro Focus Filr and choose Store all 
attachments or Store attachments larger than xx MB.

Using Filr to Manage Attachments
Once Filr is enabled in your system, you can use it to store attachments. Attachments send through 
Filr are stored in a GW Attachments folder. When you send an attachment using Filr, the items are 
automatically shared with the recipients. Use the following methods to manage your GroupWise 
attachments in Filr:

 When adding attachments to an item, select Filr reference in the bottom left corner. You can 
then select a file from Filr to attach to the item.

 When adding an attachment to an item, you can right click on the attachment and select Upload 
to Micro Focus Filr to automatically upload it to Filr.

 If your administrator has forced attachments to be sent through Filr, using a size limit or just 
having all attachments sent through Filr, you receive a warning option upon sending an 
attachment that is not in Filr and the attachment is automatically uploaded to Filr when the 
item is sent.

 Using Find, you can select Micro Focus Filr and the Find searches through your Filr files as well 
as your GroupWise items.
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 You can save received attachments to Filr in the File > Save menu.
 To open a Filr reference in an item, right click on the reference and select View in Micro Focus 

Filr.
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6 6De-Mail

De-Mail is an email security system available in Germany. It allows you to securely send confidential 
items electronically.

Enabling GroupWise for Use with De-Mail
To enable the De-Mail integration:

 In the GroupWise Admin console, select the Domain, Post Office, or user where you want the 
De-Mail integration enabled.

 Go to Client Options > Integrations > DE Mail and select Enable DE Mail integration.
 Select if you want to Use Mentana filtering or Use TSystem filtering.

With this enabled, users who send items to a De-Mail address are able to select additional De-Mail 
security options in the item header previous to sending the item.
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7 7GroupWise Identity Manager Driver for 
NetIQ Identity Manager

The GroupWise Identity Manager driver for use with NetIQ Identity Manager provides data 
integration between users in NetIQ eDirectory and GroupWise accounts in your GroupWise system. 
For example, the driver can create email accounts automatically when employees are hired. The 
driver can also disable an email account when a user is no longer active. This configurable solution 
gives you the ability to increase productivity and streamline business processes by integrating 
GroupWise and eDirectory. 

This guide provides information about certain administrative actions in the GroupWise Admin 
console that require you to stop the GroupWise Identity Manager driver or disable a user’s 
association:

 “Identity Manager Warnings in the GroupWise Admin Console” on page 39

For additional information, see:

 NetIQ Identity Manager (http://www.novell.com/documentation/idm402/)
 Identity Manager Drivers (http://www.netiq.com/documentation/idm402drivers/)

Identity Manager Warnings in the GroupWise Admin 
Console

Some GroupWise administrative actions in the GroupWise Admin console require that you stop the 
GroupWise Identity Manager driver or disable a user’s association with it before you perform the 
action. Most GroupWise administrative actions in the GroupWise Admin console require that you 
manually restart the GroupWise Identity Manager driver or re-enable the user’s association when 
you have completed the action, but a few do not. By default, these activities generate a warning 
message in the GroupWise Admin console:

 “Enabling Identity Manager Warnings” on page 39
 “Associating a GroupWise Object with an eDirectory Object” on page 40
 “Disassociating a GroupWise Object’s Attributes from an eDirectory Object” on page 40
 “Resolving an Invalid Association” on page 40

Enabling Identity Manager Warnings
Identity Manager warnings are disabled by default.

1 In the GroupWise Admin console, click System > System Preferences.
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2 Select Display Identity Manager (DirXML) Warnings, then click OK.

Associating a GroupWise Object with an eDirectory Object
Using the Identity Manager Management role in NetIQ iManager:

1 Stop the GroupWise Identity Manager driver.
2 Establish the association, as described in “Associating GroupWise Users with an LDAP Directory” 

in the GroupWise 18 Administration Guide.
3 Restart the GroupWise Identity Manager driver.

Disassociating a GroupWise Object’s Attributes from an 
eDirectory Object
In NetIQ iManager:

1 Go to the Identity Manager tab of the User object, then disable the association with the 
GroupWise Identity Manager driver.

2 Disassociate the objects, as described in “Dissociating GroupWise Users from an LDAP 
Directory” in the GroupWise 18 Administration Guide.

3 Go to the Identity Manager tab of the User object, then enable the association with the 
GroupWise Identity Manager driver.

Resolving an Invalid Association
In NetIQ iManager:

1 Go to the Identity Manager tab of the User object, then disable the association with the 
GroupWise Identity Manager driver.

2 Dissociate the user the reassociate the user, as described in “Directory Associations” in the 
GroupWise 18 Administration Guide.
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8 8Micro Focus ZENworks

The following sections provide information about using Micro Focus ZENworks to distribute the 
GroupWise Client and to virtualize the GroupWise and GroupWise Messenger.

 “Using ZENworks Configuration Management to Distribute the GroupWise Client” on page 41
 “Using ZENworks Application Virtualization for GroupWise and Messenger” on page 47

Using ZENworks Configuration Management to Distribute 
the GroupWise Client

ZENworks Configuration Management deploys software as bundles that include all the files and 
instructions required to successfully install software on users’ workstations. You can use the bundles 
to distribute the GroupWise client to workstations.

IMPORTANT: For background information, or for help completing the ZENworks tasks outlined in the 
steps below, see “Software Distribution” in the ZENworks Configuration Management section on the 
Micro Focus ZENworks Documentation website (https://www.novell.com/documentation/
zenworks/).

 “Prerequisites” on page 41
 “Using ZENworks to Distribute the GroupWise Client Software” on page 42

Prerequisites
Before creating a bundle for the GroupWise client software in Micro Focus ZENworks, you must have 
the following:

 A copy of the following GroupWise client software on the machine where you are creating the 
ZENworks Bundle:
 extract_setupip_packs.cmd
 setupip.fil
 setupip.xx (where xx is a two-letter language code)

The GroupWise client software can be found on the GroupWise server in the following location:

You can also extract the GroupWise Server installation files on your workstation if you don’t 
have access to the GroupWise server. To do this, follow the steps in “Extracting the GroupWise 
Software” in the GroupWise 18 Administration Guide.

Linux: 
Windows: 

/opt/novell/groupwise/agents/data/client/setup/win32 
c:\Program Files\Novell\GroupWise 
Server\agents\data\client\setup\win32 
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 A GroupWise MST file to customize the GroupWise install. For information on creating an MST 
file, see “Using GroupWise Client Custom Installation Options” in the GroupWise 18 
Administration Guide.

IMPORTANT: If you want a shortcut created on the desktop for GroupWise, make sure that is 
selected in the MST file.

 (Optional) A copy of the GroupWise icon which can be found on your GroupWise server in the 
following location:

\groupwise_software_path\client\win32\groupwise18.ico

Using ZENworks to Distribute the GroupWise Client Software
There are two bundles you can create to distribute the GroupWise client software. The first assumes 
that GroupWise is not installed on the target machines. The second lets the user know that 
GroupWise is being installed and prompts them to close it if it is open.

 “Creating a Bundle to Install the GroupWise Client” on page 42
 “Creating a Bundle to Install/Upgrade the GroupWise Client” on page 44

Creating a Bundle to Install the GroupWise Client
Use this bundle if your workstations do not have the GroupWise client installed.

1 In the ZENworks Control Center, on the Bundles tab, create a new Windows Empty Bundle with 
the following:
 Upload the GroupWise icon as the icon for the bundle. The icon can be found on the 

GroupWise server in the following location:
\groupwise_software_path\client\win32\groupwise18.ico

 Select Create as Sandbox and make sure Define Additional Properties is selected when you 
finish the bundle.

2 Create the following actions on the Install tab of the bundle:
2a An Install Files action called Install GroupWise Installation Files that does the 

following:
 Add the following three files:

 extract_setupip_packs.cmd
 setupip.fil
 setupip.xx (where xx is a two-letter language code)

 Select Do not compress or encrypt uploaded content if it is available.
 Set the Destination Directory to a temporary location on the machine where all of the 

GroupWise install actions can be performed. For example:
C:\Windows\Temp\gwclient\

 Under Executable security level, select Run as secure system user (Don’t allow system to 
interact with desktop).
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2b A Launch Executable action called Run extract_setupip_packs.cmd that does the 
following:
 In the Command field, specify the path to the extract_setupip_packs.cmd file 

which was placed on the device in Step 2a. For example:
C:\Windows\Temp\gwclient\extract_setupip_packs.cmd

 In the Working Directory field, specify the temporary location specified in Step 2a. For 
example:

C:\Windows\Temp\gwclient\
 In the Wait before proceeding to next action box, select When action is complete.
 On the Advanced tab, make sure Run as secure system user (Don’t allow system to 

interact with desktop) is selected.

NOTE: When this step runs on the device, a win32 folder is created in the temporary folder 
where the GroupWise client install files were placed previously. You need to know the path 
to this folder for the following steps.

2c An Install File(s) action called Install groupwise.mst that does the following:
 Add the groupwise.mst file.
 Select Do not compress or encrypt uploaded content if it is available.
 Set the Destination Directory to be the path to the win32 folder that gets created by 

the script in Step 2b. For example:
C:\Windows\Temp\gwclient\win32

 Under Executable security level, select Run as secure system user (Don’t allow system to 
interact with desktop).

2d A Run Script action called Run install.bat that does the following:
 Select Define your own script.
 Edit the script content and specify the following:

SET GW_INST_REMOVE_MSI=True
SET GW_INST_TRANSFORM_FILE=groupwise.mst
C:\Windows\Temp\gwclient\win32\install.bat /silent

The install.bat can take one of the two following parameters:

 In Wait before proceeding to next action, select When action is complete.
 On the Advanced tab under Executable Security, select Run as secure system user (Do 

not allow system to interact with desktop).

Parameter Description

/unattended Users see a window showing that GroupWise 
is being installed, but do not have to interact 
with the install.

/silent Users do not see that GroupWise is being 
installed.
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2e A Launch Executable action called Launch GroupWise that does the following:
 For Command, specify the following:

"C:\Program Files (x86)\Novell\GroupWise\grpwise.exe"

NOTE: Change this path accordingly if GroupWise was installed to a different location.

2f A Create/Delete Directory action called Delete Temporary Install Files that does 
the following:
 For Action Type, select Delete directory.
 For Directory Name, specify C:\Windows\Temp\gwclient or the temporary 

location from Step 2a.
 Under Executable security level, select Run as secure system user (Do not allow system 

to interact with desktop).
3 The bundle is now configured to install the GroupWise client. Assign the bundle to a test 

workstation to test it and make sure it is working as desired before publishing the bundle.

Creating a Bundle to Install/Upgrade the GroupWise Client
Use this bundle if your workstations have the GroupWise Client installed.

1 In the ZENworks Control Center, on the Bundles tab, create a new Windows Empty Bundle with 
the following:
 Upload the GroupWise icon as the icon for the bundle. The icon can be found on the 

GroupWise server in the following location:
\groupwise_software_path\client\win32\groupwise18.ico

 Select Create as Sandbox and make sure Define Additional Properties is selected when you 
finish the bundle.

2 Create the following actions on the Install tab of the bundle:
2a A Prompt User action called Prompt User to close GroupWise that does the 

following:
 Select the desired values for User Cancels Allowed and Seconds to be Displayed.
 Define prompts for desired locales.
 Add prompt text similar to the following:

GroupWise is ready to be installed/upgraded. Please save any 
work-in-progress emails, close all GroupWise windows, and click 
OK.

2b A Run Script action called Check for Running GroupWise that does the following:
 Select Define your own script.
 Edit the script content and add the following:
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SETLOCAL EnableExtensions
set EXE=grpwise.exe
FOR /F %%x IN ('tasklist /NH /FI "IMAGENAME eq %EXE%"') DO IF %%x 
== %EXE% goto FOUND
EXIT 0
goto FIN
:FOUND
GroupWiseStillRunning
:FIN

 In Wait before proceeding to the next action, select When action is complete.
 On the Advanced tab under Executable security level, select Run as secure system user 

(Don’t allow system to interact with desktop).
2c An Install Files action called Install GroupWise Installation Files that does the 

following:
 Add the following three files:

 extract_setupip_packs.cmd
 setupip.fil
 setupip.xx (where xx is a two-letter language code)

 Select Do not compress or encrypt uploaded content if it is available.
 Set the Destination Directory to a temporary location on the machine where all of the 

GroupWise install actions can be performed. For example:
C:\Windows\Temp\gwclient\

 Under Executable security level, select Run as secure system user (Don’t allow system to 
interact with desktop).

2d A Launch Executable action called Run extract_setupip_packs.cmd that does the 
following:
 In the Command field, specify the path to the extract_setupip_packs.cmd file 

which was placed on the device in Step 2c. For example:
C:\Windows\Temp\gwclient\extract_setupip_packs.cmd

 In the Working Directory field, specify the temporary location specified in Step 2c. For 
example:

C:\Windows\Temp\gwclient\
 In the Wait before proceeding to next action box, select When action is complete.
 On the Advanced tab, make sure Run as secure system user (Don’t allow system to 

interact with desktop) is selected.

NOTE: When this step runs on the device, a win32 folder is created in the temporary folder 
where the GroupWise client install files were placed previously. You need to know the path 
to this folder for the following steps.

2e An Install File(s) action called Install groupwise.mst that does the following:
 Add the groupwise.mst file.
 Select Do not compress or encrypt uploaded content if it is available.
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 Set the Destination Directory to be the path to the win32 folder that gets created by 
the script in Step 2d. For example:
C:\Windows\Temp\gwclient\win32

 Under Executable security level, select Run as secure system user (Don’t allow system to 
interact with desktop).

2f Do the following:
 Select the check box next to the Check for Running GroupWise Run Script action 

that was created in Step 2b.
 Click Duplicate to add another copy of this action.

This is a check to make sure the user hasn’t launched GroupWise after the initial prompt.
2g A File Removal action called Delete GroupWise Shortcut that does the following:

 For Full Path to Source Files/Directories, specify the following:

${public}\Desktop\GroupWise.lnk
 For Run Action As, make sure System is selected.

2h (Optional) A Display Message action called Alert User that GroupWise install is 
finishing that does the following:
 Define prompts for the desired locales. The message could be similar to the following:

GroupWise will finish it's install/upgrade in a few minutes. The 
application will launch automatically when finished.
Thank you for your patience!

2i A Run Script action called Run install.bat that does the following:
 Select Define your own script.
 Edit the script content and specify the following:

SET GW_INST_REMOVE_MSI=True
SET GW_INST_TRANSFORM_FILE=groupwise.mst
C:\Windows\Temp\gwclient\win32\install.bat /silent

The install.bat can take one of the two following parameters:

 In Wait before proceeding to next action, select When action is complete.
 On the Advanced tab under Executable Security, select Run as secure system user (Do 

not allow system to interact with desktop).

Parameter Description

/unattended Users see a window showing that GroupWise 
is being installed, but do not have to interact 
with the install.

/silent Users do not see that GroupWise is being 
installed.
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2j A Launch Executable action called Launch GroupWise that does the following:
 For Command, specify the following:

"C:\Program Files (x86)\Novell\GroupWise\grpwise.exe"

NOTE: Change this path accordingly if GroupWise was installed to a different location.

2k A Create/Delete Directory action called Delete Temporary Install Files that does 
the following:
 For Action Type, select Delete directory.
 For Directory Name, specify C:\Windows\Temp\gwclient or the temporary 

location from Step 2c.
 Under Executable security level, select Run as secure system user (Do not allow system 

to interact with desktop).
3 The bundle is now configured to install the GroupWise client. Assign the bundle to a test 

workstation to test it and make sure it is working as desired before publishing the bundle.

Using ZENworks Application Virtualization for GroupWise 
and Messenger

Micro Focus ZENworks Application Virtualization lets you convert applications that run on Microsoft 
Windows into self-contained virtual applications. After being virtualized, an application becomes a 
single, isolated file that runs instantly from anywhere, including a thumb drive or other removable 
media. Unlike traditional installation methods, the single virtual application file does not require a 
separate setup process, and does not rely on external components and runtimes, reboots, or 
administrative privileges. After virtualization, the application is isolated from other system 
applications, preventing DLL conflicts and other deployment nightmares, yet the experience for the 
application’s user is unchanged.

For instructions on virtualizing the GroupWise client, see “Preparing GroupWise and GroupWise 
Notify for Virtualization” in the ZENworks Integration and Streaming Guide (https://
www.novell.com/documentation/zav11/).

For instructions on virtualizing the Messenger client, see “Preparing Novell Messenger for 
Virtualization” in the ZENworks Integration and Streaming Guide (https://www.novell.com/
documentation/zav11/).
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9 9Mobile Devices

The GroupWise Mobility Service provides data synchronization between GroupWise mailboxes and 
mobile devices for synchronizing email, appointments, contacts, tasks, notes, and phone messages. 
The GroupWise Mobility Service is fast, reliable and scalable, and supports the latest device 
operating systems. For more information, see the GroupWise Mobility 18 Documentation website.

To support BlackBerry devices with an operating system earlier than BlackBerry 10.x, use BlackBerry 
Enterprise Server for GroupWise.
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10 10GroupWise TeamWorks

IMPORTANT: Support for integrating TeamWorks with GroupWise ended in GroupWise version 18.3. 
The content below is only applicable to GroupWise 18.2.1 and earlier versions.

GroupWise TeamWorks helps you easily collaborate via your web browser, mobile device, or the 
GroupWise client. With TeamWorks, you can discuss ideas, post files, share links, and invite others to 
join the conversation in virtual discussion rooms.

GroupWise is the desktop client for TeamWorks. Your TeamWorks server information is added to the 
GroupWise Admin Console by your administrator. Once that's done you can login to TeamWorks 
while in GroupWise and see the TeamWorks folders in the folder list. From within a room you can 
read, add new content, or edit content created by you.

Enabling GroupWise for Use with TeamWorks
IMPORTANT: Support for integrating TeamWorks with GroupWise ended in GroupWise version 18.3. 
The content below is only applicable to GroupWise 18.2.1 and earlier versions.

To enable the TeamWorks integration:

 In the GroupWise Admin console, select the Domain, Post Office, or user where you want the 
TeamWorks integration enabled.

 Go to Client Options > Integrations > TeamWorks and select Enable Micro Focus TeamWorks.
 Specify the TeamWorks URL and port number in the following format:

https://<teamworks_server>:<port>

Users are now able to login to TeamWorks in the GroupWise Client 

Using TeamWorks in the GroupWise Client
IMPORTANT: Support for integrating TeamWorks with GroupWise ended in GroupWise version 18.3. 
The content below is only applicable to GroupWise 18.2.1 and earlier versions.

Once your administrator has configured TeamWorks in the GroupWise Admin Console, you can use it 
to collaborate with your teams and groups.

IMPORTANT: In this release of GroupWise, you cannot create TeamWorks Rooms or Topics in the 
GroupWise client. They must be created in TeamWorks first before you can use them in the 
GroupWise Client.

You can create a comment to a topic by opening it in the room list and typing in the Reply box at the 
bottom of the Topic. Comments and topics that you have created can be edited or deleted.
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